
Beginner9s Guide to Digital Painting in Photoshop: Characters

Copyright © 3DTotal Publishing
Russian translation rights arranged with 3DTotal.com Ltd

through Alexander Korzhenevski Agency

%>744=<5 ?5DE>=465= 6 Photoshop : ?>?=>5 DG>>6>4EF6> ?> F<DD>6>-

<G D<E>64=<N / [?5D56>4 E 4=7?<=E>>7> �. �E?5=FL564] . 4 �>E>64 : ->E<>, 

2022. 4 224 E.: <?. 4 ('G<<EO D<E>64FL =4 >><?LNF5D5 < ??4=L5F5).

-F4 >=<74 ?>4>=45F EG4>6=<>4<, >>F>DO5 E>FOF E>74464FL G554<F5?L=OE < D54?<EF<G=OE 

F<DD>6OE ?5DE>=465=. �D>D5EE<>=4?O 74?44=>= <=4GEFD<< >5NOE=OF >E=>6=O5 ?D<=F<?O <E 

E>744=<O: >F 4=4F><<< < ??4EF<>< 4> >FD<E>6>< 45F4?5= >>EFN<4 < <>DM<= =4 ?<F5. �4 ?D<<5D5 

D47?<G=OE 75D>56 46F>DO ?>L47>6> D4755DGF ?D>F5EE 4<74==4 ?5DE>=464, 4 F4>65 ?><>7GF ?D>-

D45>F4FL >><?>7<F<N, D>= < 4DG7<5 646=O5 E>EF46?ONM<5 D<EG=>4.

�=<74 F4>65 D4EE>465F ?D> DG=>F<>=4? Photoshop, 57> <=EFDG<5=FO < >><4=4O, >E>55=-

=>EF< D45>FO 6 =5< < <=F5D5E=O5 ?D<5<O. % ?><>MLN ?>L47>6OE <=EFDG>F<= ?>E>5<5 =4GG<F 

>D<5=F<D>64FLEO 6 <=F5DD5=E5 ?D>7D4<<O < ?>4=<<5F 64L< D<EG=>< =4 =>6O= GD>65=L.

'�� 004.92
��� 32.973.26-018.2

�E5 ?D464 74M<M5=O. �=<74 <?< ?N54O 55 G4EFL =5 <>65F 5OFL E>>?<D>64=4, 6>E?D><76545=4 6 M?5>FD>==>= <?< <5E4=<G5E>>= D>D<5, 6 6<45 

D>F>>>?<<, 74?<E< 6 ?4<OFL -��, D5?D>4G>F<< <?< >4><<-?<5> <=O< E?>E>5><, 4 F4>65 <E?>?L7>64=4 6 ?N5>= <=D>D<4F<>==>= E<EF5<5 557 

?>?GG5=<O D47D5L5=<O >F <744F5?O. �>?<D>64=<5, 6>E?D><76545=<5 < <=>5 <E?>?L7>64=<5 >=<7< <?< 55 G4EF< 557 E>7?4E<O <744F5?O O6?O5FEO 

=574>>==O< < 6?5G5F G7>?>6=GN, 44<<=<EFD4F<6=GN < 7D4644=E>GN >F65FEF65==>EFL.

�744=<5 4?O 4>EG74

�?O L<D>>>7> >DG74 G<F4F5?5=

''��%/ $�%���&, �� ����,.&�$� � ����,�&�

%������� ��$%������ � PHOTOSHOP

 ������ $'�����%&�� �� &�$$����' $�%�����.

�?46=O= D544>F>D $. $4EEGF4<=>6. $G>>6>4<F5?L =4?D46?5=<O �. &5DUL<=4

�F65FEF65==O= D544>F>D �. �5M5DO>>64. �<F5D4FGD=O= D544>F>D .. ,=4=45D

�?44L<= D544>F>D �. �LO>>=>64. %G4>65EF65==O= D544>F>D �. �=<E<=4

�>DD5>F>DO �. �5D5??UF>64, �. ,454=>64, �. �<5?NL><=4

%FD4=4 ?D><EE>645=<O: $>EE<=E>4O $545D4F<O

,OI4DO?I4= 5?V: $5E5= $545D4F<OEO

�4F4 <77>F>6?5=<O / �>4?<E4=> 6 ?5G4FL 09.11.2021.

$>D<4F 60x841/
8
. �5G4FL >DE5F=4O. 'E?. ?5G. ?. 26,13.

&<D46          M>7. �4>47

%58

ISBN 978-5-04-156797-2
© �E?5=FL56 �., ?5D56>4 =4 DGEE><= O7O>, 2021
© �D>D<?5=<5. ��� «�744F5?LEF6> «->E<>», 2022

��� «�744F5?LEF6> «->E<>»
123308, $>EE<O, 7>D>4 �>E>64, G?<F4 �>D75, 4>< 1, EFD>5=<5 1, MF46 20, >45. 2013.

&5?.: 8 (495) 411-68-86.

Home page: www.eksmo.ru     E-mail: info@eksmo.ru

\=4VDGLV: «-�%��» �^� �4E?4EO, 

123308, $5E5=, `4?4 �jE>5G, �>D75 >qL5EV, 1 {=, 1 I<<4D4F, 20 `454F, >D<E 2013 6.

&5?.: 8 (495) 411-68-86.

Home page: www.eksmo.ru     E-mail: info@eksmo.ru.

&4G4D 55?7VEV: «->E<>»

�=F5D=5F-<4747<= : www.book24.ru

�=F5D=5F-<4747<= : www.book24.kz

�=F5D=5F-4=>5= : www.book24.kz

�<?>DFUD 6 $5E?G5?<>G �474EEF4= &�� «$�&-�?<4FO».

^474`EF4= $5E?G5?<>4EO=44IO <<?>DFF4GLO «$�&-�?<4FO» �,%.

�<EFD<5LNF>D < ?D54EF46<F5?L ?> ?D<5<G ?D5F5=7<= =4 ?D>4G>F<N, 

6 $5E?G5?<>5 �474EEF4=: &�� «$�&-�?<4FO»

^474`EF4= $5E?G5?<>4EO=44 4<EFD<5LNF>D 6j=5 q=V< 5>=O=L4 4DO7-F4?4?F4D4O 

`45O?44GLO=O� q>V?V «$�&-�?<4FO» �,%,

�?<4FO `.,  �><5D>6E><= >qL.,   3«4», ?<F5D �, >D<E 1.

&5?.: 8 (727) 251-59-90/91/92;  E-mail: RDC-Almaty@eksmo.kz

\=V<=V� 64D4<4O?O` <5D7V<V L5>F5?<575=.

%5DF<D<>4F<O FGD4?O 4`?4D4F  E4=FF4: www.eksmo.ru/certiû cation

%6545=<O > ?>4F65D645=<< E>>F65FEF6<O <744=<O E>7?4E=> 74>>=>44F5?LEF6G $$ 

> F5E=<G5E>>< D57G?<D>64=<< <>6=> ?>?GG<FL =4 E4=F5 �744F5?LEF64 «->E<>»

www.eksmo.ru/certiû cation

\=4VD75= <5<?5>5F: $5E5=. %5DF<D<>4F<O `4D4EFODO?<4I4=

�$�%�����/�&�%, � ���! 

bomborabooks bombora

bombora.ru

�/ � %�&%�&/%:

�����$� 3 ?<45D =4 DO=>5 ?>?57=OE 
< 64>E=>6?ONM<E >=<7. �O ?N5<< >=<7< 
< E>7445< <E, GF>5O 6O <>7?< F6>D<FL, 
>F>DO64FL <<D, ?D>5>64FL =>6>5, D4EF<. 
�OFL EG4EF?<6O<<. �OFL =4 6>?=5.

12+









%>45D64=<5

�6545=<5  08

�4G4?>  10

�4EFD>=>4 E>?EF4  12

�4> E?D46<FLEO E ?GEFO< E>?EF><  20

�4EFD>=>4 ><EF5= 28

�4EFD>=>4 ?4?<FDO F65F>6  36

%>744=<5 ?5DE>=464  42

$>D<4 < EFD>5=<5 F5?4  44

�<4O ?5DE>=465=  54

�><?>7<F<O  62

�>65EF6>64=<5 < =4EFD>5=<5 ?5DE>=465=  72

�>O6?5=<5 ?5DE>=464  80

�<4O F5?>E?>65=<O < >>6<  82

�4> =4D<E>64FL ?<F>  88

�4> =4D<E>64FL 6>?>EO  96

%>744=<5 >>EFN<4  104

�>74 < 744=<= D>=  112

&6>DG5E><= D45>G<= ?D>F5EE  120

�GEFO==O= G5?>65>  122

�5D><=O Sci-fi  134

%D54=565>>6O= LGF  142

&>D7>65F  150

�>4E>47><  160

�>?>EO  162

�>64  167

'L< <  7?474  172

�>E < D>F/7G5O  176

�5E < <4F5D<4?O 4?O >4564O  181

'>D4L5=<O <  74465FO  185

�4?5D5O D<EG=>>6  188

%?>64DL  210

�=4>><EF6> E EG4>6=<>4<<  221

�?D46<F=O= G>474F5?L  222



�E=>64 <=4GEFD<< D476?5G5=<=  4 FO74 >  ?>-

65EF6>64=<N < ?D464>?>4>5=>EFL 75D>56, GLO 

<EF>D<O < 6<7=L =4E>4OFEO 6 DG>4E EG4>6=<-

>4. %D54< =<E E4<O= ?>?G?OD=O= <=EFDG<5=F 

4?O E>744=<O G=<>4?L=OE <  6OE>>>>4G5-

EF65==OE ?5DE>=465=  4 Photoshop E  5>74-

FO< 6O5>D>< <=EFDG<5=F>6, >>F>DO5 ?57>> 

=4EFD><FL ?>4 E55O. �D>7D4<<4 ?D54?4745F 

=5 F>?L>> G4>5EF6> < 5OEFD>FG, => < 6>7<>6-

=>EFL >4D4<=4?L=> <5=OFL F65F4 <7>5D465-

=<O, 4  F4>65 <E?>?L7>64FL D47?<G=O5 ><EF< 

4?O E>744=<O 6?5G4F?ONM<E < ?D464>?>4>5-

=OE F5>EFGD. -F> >F?<G=O= E?>E>5 >FF>G<FL 

64L< F6>DG5E><5 =46O><.

�7GG<6 E4<O5 6?5G4F?ONM<5 >>=F5?FO 2D-

?5DE>=465= 6  <=F5D=5F5, >=<74E, D<?L<4E 

<  <7D4E, 6O >5=4DG6<F5 4>6>?L=> 5>?LL>5 

D47=>>5D47<5 4<74==>6. &4> >4> 65 =4=F< 

?D46<?L=O= 4?O 64E EF<?L < 6>??>F<FL 64L< 

<45<? �OOE=<FL, >4> ?5DE>=46 5G45F 6O7?O-

45FL <  65EF< E55O  4 =5?D>EF4O 7444G4. �?O 

F>7> GF>5O >= >EF464?EO G7=4645<O<, 646=> 

74D<>=<7<D>64FL D>D<O, F65F4, F5>EFGDO 

<  =4EOM5==>EFL. �5D5G<E?5==O5 ?4D4<5FDO 

<>7GF E  ?57>>EFLN ?>6?<OFL =4 =4EFD>5=<5 

<  E?>E>5=>EFL 75D>O D4EE>474FL E6>N <EF>-

D<N.

�O E>5D4?< >><4=4G >5GG5==OE, ?D>D5EE<>-

=4?L=OE 4<46<F4?-EG4>6=<>>6. �=< =4GG4F 

64E DG=44<5=F4?L=O< >E=>64< F<DD>6>7> 

E>744=<O ?5DE>=465=. � >>=F5 >=<7< 6O =4=-

45F5 74<5G4F5?L=O= E?>64DL �D4<4 «�>>>» 

%5?E4 E  E4<O<< =5>5E>4<<O<< F5D<<=4<<. 

�D><5 F>7>, 6O <>65F5 >5D4M4FLEO >  =5<G, 

?>>4 G<F45F5 >=<7G, GF>5O D47>5D4FLEO 6 F>=-

>>EFOE F<DD>6>7> D<EG=>4.

�65EE %5DL5=F-&<??<=7

�4<5EF<F5?L D544>F>D4, 

<744F5?LEF6> 3Dtotal

�6545=<5



%.9

%. 10

%.11

%.9

%. 10

%.11



10



�4G4?>
�4> ?GGL5 6E57> =4EFD><FL D45>G55 
?D>EFD4=EF6> < DG=>F<< 6 Photoshop

%>744=<5 ?5DE>=465= 6 Photoshop <>65F ?>>474FLEO ?G74NM<<. 

�5=<F4 �<=>?5D ?><>65F 64< ?>47>F>6<FLEO < =4G4FL D<E>64FL. �=4 

=4GG<F 64E >E>55==>EFO<, <=EFDG<5=F4< < ?>?57=O< DG=>F<O<, 

>>F>DO5 EF4=GF >E=>6>= D45>G<E ?D>F5EE>6. � MF>< D4745?5 �5=<F4 

D4EE>465F 64< >  F><, >4> =4EFD><FL E>?EF < E?>< 4?O D<E>64=<O, 

?D5>4>?5FL EFD4E G<EF>7> ?<EF4, E>744FL 5<5?<>F5>G ><EF5= 

< D47>5D4FLEO E F65F>6>= ?4?<FD>=. -F> >55E?5G<F =4456=O= 

DG=44<5=F 4?O F>7>, GF>5O >>G=GFLEO E  7>?>6>= 6 >5GG5=<5.



 · �4EF46>4 Photoshop CC 01

 ·  &4> 6O7?O4<F <=F5DD5=E Photoshop E >D<7<=4?L=O<< =4EFD>=>4<< D45>G57> ?D>EFD4=EF64 02a

�4EFD>=>4 E>?EF4
�4> ?>47>F>6<FL D45>G55 ?D>EFD4=EF6> 4?O E>744=<O ?5DE>=464

�5=<F4 �<=>?5D

�O =4GG<F5EL:

• =4EFD4<64FL E>?EF;

• =4EFD4<64FL E?>< 4?O D<E>64=<O;

• E>74464FL E>5EF65==GN 5<5?<>F5>G ><EF5=;

• D475<D4FLEO E F65F>6>= ?4?<FD>=.

�> 6EFG?<F5?L=>= 7?465 <O >5D4F<< E6>= 

677?O4 =4 Photoshop CC <  G7=45<, >4> 57> 

<>6=> <E?>?L7>64FL 4?O E>744=<O 75D>56. 

�E?< 6O EG4>6=<>-=>6<G>> <?< 65 >5?4445-

F5 =55>?LL<< >?OF><, => =<>>744 =5 D45>-

F4?< E  F4><<< ?D>7D4<<4<<,  4 >F?<G=>! �O 

>>474?<EL 6 ?D46<?L=>5 6D5<O 6 ?D46<?L=>< 

<5EF5.

�5D54 F5< >4> <O =4G=5<, O  E>GG E>474FL: 

Photoshop  4 4>6>?L=> >5N5<=4O ?D>7D4<<4. 

�4 ?5D6O= 677?O4 >=4 <>65F ?>>474FLEO =4-

EF>OM<< <>=EFD>< (4>6>?L=> <<?O<, <564G 

?D>G<<). ' 64E =5 ?>?GG<FEO >6?445FL 6E5<< 

F>=>>EFO<< 74 >4<= D47. �54L <O ?D<L?< 

E 64<< 74 D57G?LF4F><, =5 F4> ?<?

�?O =4G4?4 <O 6>7L<5< 74 >5D475F G65 

E>744==>7> ?5DE>=464 <  =4 57> ?D<<5D5 

=4EFD><< 4>>G<5=F 4?O D<E>64=<O. ,47<, 

>>F>DO5 <O E45?45<, 444GF 64< ?>=<<4=<5 

< >E=>6G 4?O 44?L=5=L57> >5GG5=<O. �>F GF> 

64< ?>=44>5<FEO:

• 547>6O5 7=4=<O D<E>64=<O;

• Photoshop CC (5E?< G  64E 5>?55 EF4D4O 

65DE<O, =4?D<<5D CS 5, 4 =<G57> EFD4L=>-

7>, F>?L>> >4DF<=><-?D<<5DO <>7GF 6O7?O-

45FL =5<=>7> ?>-4DG7><G);

• E>D>L<= 7D4D<G5E><= ??4=L5F, 65?4F5?L-

=> E 6OE>>>= GG6EF6<F5?L=>EFLN > =46<<G; 

=>, 6  ?N5>< E?GG45, <E?>?L7G=F5 F>, GF> 

5EFL G 64E ?>4 DG>>=;

• =5<=>7> F6>DG5E>>7> 557G<<O (>G5=L ?>-

?57=>!)

%>744=<5 ?5DE>=465= 6 Photoshop. �>?=>5 DG>>6>4EF6> ?> F<DD>6><G D<E>64=<N12



· �77?O=<F5 =4 <=F5DD5=E. �4 ?4=5?< «�?F<=» >FD465=O >?F<< 6O5D4==>7> <=EFDG<5=F4, 6 44==>< E?GG45 4 <=EFDG<5=F «�5D5<5M5=<5» 03a

025

�4=5?L �=EFDG<5=F>6 (=<5») 

�4=5?L >>?>=>< E> E7DG??<D>64==O<< 
?4=5?O<< E 6>?44>4<<

�>?>=>4 6F>D>EF5?5==OE ?4=5?5= 

�4=5?L >?F<=

�4=5?L ?D<?>65=<= (%FD>>4 �5=N)

�4=5?L <>>=>> <5=N

· �O55D<F5 «�E=>6=GN D45>GGN ED54G», GF>5O G =4E 5O? >4<=4>>6O= =45>D ?4=5?5=. 
�E?< 5EFL =5>5E>4<<>EFL 4 =46<<F5 «%5D>E<FL 4> �E=>6=>= D45>G5= ED54O»

,47 01
�F> 5M5 ?>?L7G5FEO 
Photoshop?
�46=> ?>=OFL, GF> 5?47>44DO L<D>>><G DG=>-

F<>=4?G Photoshop << ?>?L7G5FEO 5>?LL>5 

>>?<G5EF6> ?D>D5EE<>=4?>6 (F5?5DL ?>=OF=>, 

?>G5<G 6  MF>= ?D>7D4<<5 F4> <=>7> 6E57>!). 

%D54< 57> ?>?L7>64F5?5= 5EFL: EG4>6=<><-<?-

?NEFD4F>DO, EG4>6=<><-D5FGL5DO, >>F>DO5 

D45>F4NF 4?O 7?O=F56OE 6GD=4?>6, 4=<<4-

F>DO >=?4==-<7D <  EG4>6=<><-4>D<E>6M<><, 

>>F>DO5 4>?6=O G<5FL E>74464FL D45>FO 

E>7?4E=> G5F><< FD55>64=<O< ><=>EFG4<=; 

<>4=O5 4<74==5DO, >>=F5?F-EG4>6=<><, EF<-

?<EFO, 655- <  7D4D<G5E><5 4<74==5DO <, >>-

=5G=> 65, D>F>7D4DO.

�>G5<G 65 64< 4>?65= 5OFL <=F5D5E5= E?<-

E>> ?D>D5EE<=? �D>EF> F4>>5 D47=>>5D47<5 

>7=4G45F, GF> 4?O E>744=<O ?5DE>=465= 64< 

=5 ?D<45FEO GG<FLEO 45E>?NF=> 6E5< DG=>-

F<O<  4 F>?L>> ?GGL<< <  E4<O< =5>5E>-

4<<O<. �>F>6O =4G<=4FL? �464=F5 >F>D>5< 

Photoshop.

,47 02
�4EFD4<645< D45>G55 <5EF>
�E?< 6O F>?L>> GEF4=>6<?< Photoshop, F> G6<-

4<F5 EF4=44DF=O= <=F5DD5=E, >>F>DO= =47O-

645FEO «�E=>6=4O D45>G4O ED544» (Essentials 

workspace). �= ?D54?4745F EF4=44DF=O= =45>D 

DG=>F<=, >>F>DO5 <E?>?L7GNFEO G4M5 6E57> 

(>4DF<=>4 024).

�4> <O 6OOE=<?< D4=55, Photoshop ?>?L7GNF-

EO D47=O5 7DG??O ?>?L7>64F5?5=, <  ?>MF><G 

>464><G <7 =4E 4>EFG?=O D47=O5 =45>DO 

DG=>F<=. �?47>44DO 6>7<>6=>EF< 7?G5>>>7> 

D544>F<D>64=<O, Photoshop ?>76>?O5F E>744FL 

<4>E<<4?L=> G4>5=GN <<5==> 4?O 64E D4E-

EF4=>6>G DG=>F<=.

�>>4 «�E=>6=>= D45>G5= ED54O» =4< 5G45F 

4>EF4F>G=>; <O 5G45< G4EF> <E?>?L7>64FL 

6>?44>G «�>DD5>F<O» (Adjustments panel), 

?>MF><G 6O <>65F5 GEF4=>6<FL 55 F4>, >4> 

?>>474=> =4 >4DF<=>5 024. (�O  677?O=5< =4 

«$56<< $<E>64=<O» (Painting mode) ?>765, 

F4> GF> 6O E<>65F5 ?>M>E?5D<<5=F<D>64FL 

< E =<<).

�5 6>?=G=F5EL, 5E?< 6O D4=LL5 >F>DO64?< 

Photoshop, ?><5=O?< GF>-F> <?<, <>65F 5OFL, 

G5D4?< >4><5-F> 6>?44>< <  =5 7=45F5, >4> <E 

65D=GFL. �  ?D46>< 65DE=5< G7?G 5EFL >?F<O 

6>76D4F4, >=4 =47O645FEO «%5D>E<FL 4> �E-

=>6=>= D45>G5= ED54O» (Essentials) (>4DF<=>4 

025). �46<<F5 >=>?>G «�>EEF4=>6<FL �E=>6-

=GN D45>GGN ED54G» (Reset Essentials), <  6O 

65D=5F5EL > EF4=44DF=O< GEF4=>6>4<.

,47 03
�=4>><EF6> E <=F5DD5=E><
�464=F5 <7GG<< <=F5DD5=E 6=<<4F5?L=55. �45 

D4E?>?>65=O 6E5 E4<O5 =5>5E>4<<O5 >=>?-

><? � ?56>= G4EF< G =4E 5EFL ?4=5?L «�=EFDG-

<5=FO» (Tools bar); 6 ?D46>= G4EF< 4 ?4=5?L 

>>?>=>>, 745 E>5D4=O G4EF> <E?>?L7GNM<5EO 

64<< DG=>F<<. �E?< 6O =46<5F5 =4 ?4=5?L, 

>=4 6O6545F E>>F65FEF6GNMGN 6>?44>G =4 

M>D4= <  4>F<6<DG5F 55 (6O  <>65F5 6<45FL 

4>F<6<D>64==GN 6>?44>G E?>56 =4 >4DF<=>5 

034; >=4 5G45F 64< =G6=4 ?>EF>O==>).

� 65DE=5= G4EF< M>D4=4 =4E>4<FEO «%FD>>4 

�5=N» (Menu bar), F4>65 55 =47O64NF ?4=5?L 

«�D<?>65=<=» (Application bar): >=4 =4E>4<F-

EO =44 ?4=5?LN «�?F<=» (Options bar), >>F>-

D4O >FD4645F DG=>F<< 6O5D4==>7> <=EFDG-

<5=F4; >4> F>?L>> 6O ?><5=O5F5 <=EFDG<5=F, 

?4=5?L E>>F65FEF6GNM<< >5D47>< <7<5=<FEO. 

�46=> =4=F< <>>=>G «%FD>>< �5=N». �4?D<-

<5D, 5E?< 6O 74E>F<F5 74>DOFL >4=G <?< 

7DG??G ?4=5?5=, F> >5=4DG6<F5 6>7<>6=>EFL 

E45?4FL MF> 6  ?4=5?< 6O?444NM57> <5=N 

(F>G=> F4> 65 <>6=> ?>EFG?4FL <  E  4DG7<<< 

DG=>F<O<< 6 E>>F65FEF6<< E F5<4F<>>= >?D5-

45?5==>= ?4=5?<).

13 �4G4?>



035

�<=<<<7<D>64FL

�5D5>?NG4F5?L «E?DOF4FL/?>>474FL»

 ·   �46<<F5 =4 EFD5?>G, GF>5O G<5=LL<FL ?4=5?L 036

 · �4> 74>DOFL 7DG??G 6>?44>> 037 · �F>D>=F5 =>6GN 6>?44>G, GF>5O 
6>?NG<FL <=EFDG<5=FO. �5D4F<F5 
6=<<4=<5 =4 F>, GF> >F>DOFO5 6>?44>< 
G65 >F<5G5=O

�E?< 6O E>F<F5 >F>DOFL 6>?44>G «�<EF<» 

(Brush panel), ?D>EF> =46<<F5 «�>=>»> «�<-

EF<» (Window > Brush) (D<EG=>> 035), F>744 

?4=5?L 74>D5?<F <>>=>G =4 EF>?5F5, >4> =4 

>4DF<=>5 036.

�E?< =4?D>F<6 >?F<< EF><F 74?>G>4, 7=4G<F 

?4=5?L G65 >F>DOF4 =4 6>?44>4E EF>?5F>6 ?4-

=5?<. �46<<F5 =4 EFD5?><, GF>5O G<5=LL<FL 

><EFL, <  =4 EFD5?>G>G 6  ?D46>< G7?G ?4=5?<, 

GF>5O E>DOFL 55 <?< ?>>474FL (>4DF<=>4 036). 

�4>DOFL ?4=5?L 7DG?? ><EF5= <>6=>, =4646 

>=>?>G «�4>DOFL 7DG??G 6>?44>>» (Close Tab 

Group) (>4DF<=>4 037).

,47 04
->D4==O= D>D<4F <?< D>D<4F 
4?O ?5G4F<?
� 746<E<<>EF< >F F>7>, GF> 6O ??4=<DG5F5 =4-

D<E>64FL, =G6=> E>744FL D4=? ?<5> 6 M>D4=-

=>< D>D<4F5, ?<5> 6  D>D<4F5 4?O ?5G4F<. 

�  =4G4?5 D45>FO 6O 5M5 =5 7=45F5, 5G45F ?< 

64< =5>5E>4<< ?>74=55 64D<4=F 4?O ?5G4F<. 

�><=<F5, 5E?< 6O E>7445F5 <  D544>F<DG5F5 

?5DE>=464 6 D47D5L5=<< 4?O M>D4=4 (72 dpi), 

F> ?>F>< =5 E<>65F5 D4E?5G4F4FL 57> 6 5>?55 

6OE>>>< >4G5EF65 (>4DF<=>4 044). �>>G<5=FO 

4?O ?5G4F< 6 6OE>>>< D47D5L5=<<, F5< =5 <5-

=55, <>7GF 5OFL >>=65DF<D>64=O 6  M>D4==O= 

<?< <=F5D=5F-D>D<4F 557 ?>F5D< >4G5EF64.

�464=F5 E>7444<< D4=? 6  M>D4==>< D47D5-

L5=<< (O >5NOE=N, >4> D45>F4FL E D>D<4F>< 

4?O ?5G4F<, ?>MF><G 6O E<>65F5 6O5D4FL 

=4< 5>?55 ?>4E>4OM<= 64D<4=F).

� 65DE=5= EFD>>5 <5=N =46<<F5 «$4=?» > 

«%>744FL» (File > New), F5?5DL 6  4<4?>7>6>< 

>>=5 6O55D<F5 «�D5E5F: �?O <=F5D=5F4» (Preset: 

Web) < 44=F5 D4=?G <<O. �O 5G45< E>74464FL 

?5DE>=464, >>F>DO= EF><F, ?>MF><G =4< =5>5-

E>4<<O ?>DFD5F=O5 D47<5DO. �7<5=<F5 EF4=-

44DF=O5 ?4D4<5FDO 4> 600 ?<>E5?5= 6 L<D<=G, 

< 800 ?<>E5?5= 6 6OE>FG. �4764=<5 =45>D4 ?>-

<5=O5FEO =4 <7<5=5==O=, ?>>47O64O =4EFD>5=-

=O5 ?4D4<5FDO. �5 <5=O=F5 4DG7<5 7=4G5=<O 

< =46<<F5 «%>744FL» (OK) (>4DF<=>4 045).

�?O ?5G4F=>7> D47D5L5=<O =46<<F5 «�D5E5F: 

�5G4FL» (Preset: International Paper), F>744 

G 64E ?>?GG<FEO 4>>G<5=F �4, E >4G5EF6>< 300 

dpi (>4DF<=>4 04E). �>E?5 MF>7> ?5D54 64<< 

?>O6<FEO =>6O= 4>>G<5=F. �46<<F5 «$4=?»> 

«%>ED4=<FL >4>» (File > Save As), <  >EF46L-

F5 EF4=44DF=O= D>D<4F PSD. �E?>?L7G=F5 

<=EFDG<5=F «�4ELF45» (Zoom tool) (Z) 4?O 

?5D5<5M5=<O (>4DF<=>4 044).

%>744=<5 ?5DE>=465= 6 Photoshop. �>?=>5 DG>>6>4EF6> ?> F<DD>6><G D<E>64=<N14



· %?564: >D<7<=4?L=>5 >4G5EF6> 4?O 6OE>>>7> D47D5L5=<O ?5G4F=>7> 4>>G<5=F4 (300 dpi); %?D464: 6 D57G?LF4F5 ?>?OF>< D4E?5G4F4FL >4DF<=>G 
6 M>D4==>< D47D5L5=<< (72 dpi) ?>O6OFEO 74<5F=O5 ?<>E5?<

04a

· �4EFD>=>< 4?O <=F5D=5F4/->D4=4 045

047

· �4EFD>=>< 4?O ?5G4F=>7> 64D<4=F4 046

· �4L =>6O= 4>>G<5=F (D47<5D 
600x800 ?<>E5?5=) 6 <4ELF455 100%. 
�>?D>5G=F5 <E?>?L7>64FL <=EFDG<5=F 
�4ELF45 (Z)
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 ·   '65?<G5=<5 >FE>4=<D>64==>7> <7>5D465=<O. 'F>5O <7<5=<FL ?D>?>DF<<, 746<<F5 Shift, ?>>4 FO=5F5 74 F>G><, <?< =46<<F5 =4 <>>=>G F5?< 065

 · �7<5=<FL E?>= ME><74 (Ctrl + T) 06a

 · �4EFD>=>< 4?O <7<5=5=<O D47<5D>6 E>?EF4 05

=4EFD>=>4 ?D>?>DF<=

>F<5=<FL
?>4F65D4<FL 

,47 05
%5>D5F <5?><E 45F4?5=: D47<5D 
E>?EF4
�4> E>744FL <=F5D5E=O5 45F4?<? �>F <4-

?5=L><= D>>GE: 6=5 746<E<<>EF< >F D47<5D4 

E>?EF4, G65?<GLF5 57> 6  464 D474! -F> 44EF 

6>7<>6=>EFL ?D>65EF< F>=>GN D45>FG ><EFLN, 

>>F>DGN ?D4>F<G5E>< =56>7<>6=> 6O?>?=<FL 

<=4G5. �4> F>?L>> 6O 74>>=G<F5, 65D=<F5 D47-

<5DO E>?EF4 >5D4F=>. �4>546>> 5?47>44DO 

G<5=LL5=<N <4ELF454 <EG57=GF 6E5 L5D>E>-

64F>EF<. �46<<F5 «�7>5D465=<5» > «$47<5D 

�7>5D465=<O» (Image > Image Size) < 6 65DE-

=5= EFD>>5 <5=N 6654<F5 7=4G5=<5 6OE>FO 

1600 ?<>E5?5=. &4> >4> ?4D4<5FDO E6O74=O 

<564G E>5>= <>>=>>= F5?<, ?4D4<5FD L<D<-

=O 5G45F 46F><4F<G5E>< D4EEG<F4= 4> 7=4G5-

=<O 1200 ?<>E5?5=. &5?5DL =46<<F5 ��.

%>744=<5 ?5DE>=465= 6 Photoshop. �>?=>5 DG>>6>4EF6> ?> F<DD>6><G D<E>64=<N16



· '<5=LL5=<5 <?< G65?<G5=<5 64L57> E>?EF4 07

,47 06
�4> E>>?<D>64FL < 6EF46<FL 
<4F5D<4?O <7 >4=>7> 4>>G<5=F4 
6 4DG7>=
�E=>6=4O F5?L E?54GNM57> L474  4 =4G-

G<FLEO >>?<D>64FL <  6EF46?OFL <4F5D<4?O 

<7 >4=>7> 4>>G<5=F4 6  4DG7>= <  D47<5M4FL 

<4F5D<4?O =4 E>?EF5. -F4 F5E=<>4 =4< ?>=4-

4>5<FEO 6 44?L=5=L5<.

'F>5O >F>DOFL E>>?<D>64==O= D<EG=>>, =4-

6<<F5 «$4=?» > «�F>DOFL» (File > Open) 

<  6O55D<F5 =>6O= D4=? (Ctrl + A). �4F5< 

E>>?<DG=F5 6O5D4==O5 <4F5D<4?O (Ctrl + C). 

�>F<6<DG=F5 ?5D6GN 6>?44>G (7?46=O= 4>>G-

<5=F), GF>5O 6O65EF< =4 ?5D54=<= ??4=, 4 74-

F5< =46<<F5 Ctrl+V < 6EF46LF5 <E.

� 746<E<<>EF< >F D47<5D>6 >FE>4=<D>64==>-

7> ?5DE>=464, >= <>65F ?>>474FLEO =4 E>?-

EF5 E?<L>>< 5>?LL<< <?< E?<L>>< <4?5=L-

><<. �46<<F5 Ctrl + T, 6>?NG<F5 <=EFDG<5=F 

«%6>5>4=>5 FD4=ED>D<<D>64=<5» (Transform) 

< ?5D5F4M<F5 F>G><, GF>5O <7<5=<FL <4ELF45 

<  ?>?>65=<5 E?>O ME><74, <  ?>4F65D4<F5 

(677?O=<F5 =4 >4DF<=>G 065). &5?5DL E>ED4-

=<F5 D4=?.

«�E?>?L7G=F5 <=EFDG<5=F 
<$4<>4= 4?O <7<5=5=<O 
D47<5D>6 64L57> E>?EF4. 
�4< MF> ?>=D46<FEO»

,47 07
�>D45>F>4 D47<5D>6 < ?>?>65=<O 
E>?EF4
�4 44==O= <><5=F ?5D54 =4<< ?>DFD5F=O= 

E>?EF. �?O >4=>7> ?5DE>=464  4 6  E4<O= 

D47. �> GF>, 5E?< ?>74=55 <O 74E>F<< ?>-

<5=OFL D47<5DO ?DO<> 6> 6D5<O D<E>64=<O? 

�>65F 5OFL, =4< ?>=44>5<FEO 5>?LL5 <5EF4 

E?564 <  <5=LL5 <5EF4 6=<7G? �?< <O 74E>-

F<< ?><5=OFL D47<5DO F5?<>>< < ?D56D4F<FL 

?>DFD5F 6  ?5=746, =4 >>F>D>< >4<= ?5DE>-

=46 5G45F <7>5D465= =5E>>?L>> D47, GF>5O 

=4 >4=>= <  F>= 65 D<7GD5 ?>>474FL D47=O5 

64D<4=FO >4564O.

%4<O= G4>5=O= E?>E>5  4 <E?>?L7>64FL 

<=EFDG<5=F «$4<>4» (Crop). �4< >5O74F5?L-

=> ?>=D46<FEO  4 57> <>6=> <E?>?L7>64FL 

>4> 4?O G<5=LL5=<O, F4> <  4?O G65?<G5=<O 

 E>?EF4.

�464=F5 ?>E<>FD<<, >4> >= D45>F45F. �O55-

D<F5 <=EFDG<5=F «$4<>4» (7>DOG4O >?46<L4 

C), ?D< ?><>M< 6O45?5==>= >5?4EF< >?D5-

45?<F5 =5>5E>4<<GN 7>=G (?DO<>G7>?L=<>, 

>>F>DO= ?>O6?O5FEO, >>744 6O FO=5F5 >GD-

E>D G5D57 E>?EF), 74F5< ?D< ?><>M< F>G5> 

4>>GD4F=> D4EFO=<F5 4> F>7> <><5=F4, ?>>4 

=5 ?>GG6EF6G5F5, GF> 6O 4>6>?L=O =>6O<< 

D47<5D4<<. �=< 5G4GF GEF4=>6?5=O, >>744 

6O =46<5F5 >=>?>G «�>76D4F» (Return) (<?< 

74?>G>G 6 65DE=5= ?4=5?< <5=N). �<>E5?< 6=5 

6O45?5==>= 7>=O EF4=GF E5D>7> F65F4 <  5G-

4GF G44?5=O, 5E?< EF><F D?46>> «'44?<FL 

�OD574==O5 �<>E5?<» (Delete Cropped Pixels) 

6  65DE=5= ?4=5?< <5=N. �E?< 65 D?46>> =5 

EF><F, Photoshop ?D56D4F<F F>, GF> 6O 6OD5-

74?<, 6  =>6O= E?>=, 745 =5=G6=O5 ?<>E5?< 

5G4GF E?DOF4=O 6=5 7>=O 6<4<<>EF<.

17 �4G4?>


